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About this Release

In each release there may be new features and functions that require one or all of the following:

· Purchase of a module to access

· User Training

· Specific process to be used to ensure the correct functioning

Please read the release notes and the corresponding manual pages to ensure that you understand the changes being
made, what module they are associated with, and how they impact your business processes.

If you have any questions about anything in a release, please contact support either by phone or through a Redmine ticket.

Release Notes for CareRight 7.4.0
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Major Features

Charts

  Experimental feature: This is not generally available to all customers at this time, and is subject to further revision.

Main article: Charts

Further improvements, with a focus on fluid charting and performance.

Postcodes > Source swapped to Australia Post

For a number of years, CareRight utilised VAED supplied postcodes. The primary source is now Australia Post.

Main article: Postcodes

Enhancements

Receipt Number Generation

  Core architecture change
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For a number of years, CareRight maintained feature parity with its predecessor product, The Specialist. A key component
was the use of Counter Sets, which were used for the generation of various database identifiers in that legacy system.

Modern relational database systems provide the concept of sequences which fulfill the same purpose; built in as a core
database concept.

We have migrated the Receipt, Refund and Invoice behaviours within the system to rely on this core database concept.
As this is a low level, fundamental architectural change as this becomes available we will establish with you a pre and post
go live monitoring plan to detect any issues.

Providers > Provider Dashboard and locked down access

  Experimental feature: This is not generally available to all customers at this time, and is subject to further revision.

Main article: Provider Dashboard (view own patients)

For customers where providers operate with a limited subset of patients; ie as a third party contracted clinician; CareRight
now supports a specific Provider Dashboard experience.

Where a provider is granted a new permission; view_own_patients; access to that patient record is only granted where
there is a direct relationship via:

Primary Provider is the logged in clinician or

There is a case where logged in clinician is a case worker or

There is an appointment with the logged in clinician

A more limited subset of links and options is presented to providers when logged in in this mode.

This feature is likely to further evolve, adding additional accesses (ie: Programs, Admission or Task based relationships) and
is not recommended for general use.

Workflow > Workflow Manager > Ability to archive

CareRight now features a new permission, Workflow Manager. With this permission, the ability to transition a workflow
to Archived is available at any stage.

http://careright.knowledgeowl.com/help/provider-dashboard-view-own-patients


Metrics > Not Assessed

Support for marking a metric required, but additionally not assessed is available. To upgrade your assessments, this requires
a new version.



Correspondence > Show > When rendering a letter, render the attachments associated

In some areas of the product, when viewing correspondence relating to a previously sent letter, the full details of the letter
was not visible. We have adjusted these views to be consistent across viewing both Letters and Correspondence

Clinical Notes > Improve pagination controls

We have expanded the default number of clinical notes shown to be 100, with the pagination controls shown at the top
and bottom of lists.

This caters for hospital/longer admissions with an ongoing clinical note history.

Forms > On screen submit buttons

For areas of the application with very long forms, the submit button of forms is now on screen.

Admin > Event settings > Ability to hide patient account selection controls

Correspondence > Letter Generation > Support for Scalable Vector Graphic (SVG) images

Main article: Replacing the Default Letterhead

http://careright.knowledgeowl.com/help/replacing-the-default-letterhead


CareRight now better supports SVG in correspondence rendering. This enables your design team to create extremely
sharp letterheads, logos and similar for use within the CareRight product; while minimising the size of generated PDF
output - important for certain secure messaging providers or upload to My Health Record.

Example: The Ghostscript Tiger test case as an SVG element.

Assessments > Item Picker > Remove Discontinued Items from Item Picker

We have improved the item picker control in the assessment builder 

SAML Authentication > User locator strategies and post authentication strategies

As Microsoft Entra defaults to a NameID strategy of Persistent; but presents different NameIDs across configured
applications; this often presents issues with UAT vs production credentials.

To eliminate this issue, we have enabled a configurable Object Identifier based authentication method; which is more
stable.

Professional Contacts > Require contact_editor role

Previously, the system supported both 'admin role' and 'contact editor role'.

We have now reduced the editing of professional contacts to 'contact editor'

https://en.wikipedia.org/wiki/SVG


Healthlink > Move HLK Core values out of EDI field

We have introduced distinct modelling for the EDI vs HLK Core identifiers.

Online Enquiries > Optionally disable text area

Now available via a setting under Admin > Correspondence > Enquiry Categories

Online Booking > Configuration for how many weeks of booking slots are shown

Defects & minor enhancements

Regression with default labels: display-align="left" after upgrade of printing component.

Telehealth - Product Default Templates - Appointment Cancelled notification with iCalendar attachment

Fix z-index issue with some popups

Appointments > Edit > Theatre > Now limited to up to 1000 assistant contacts; who are either a surgeon or specialist.

Add ability to archive contacts



Printing failure: Fix lengths of backtraces

Fix values not showing up on previous banking reports

Fix [Fatal Error] healthlink_pdf_1727399969_50546884550440.xsl:1:15: The value following "version" in the XML

declaration must be a quoted string edge case

Fix ePrescribing - failure to display errors - ensure array for send prescription partial

Add send_email trigger script method, to mirror send_sms.

Fix minor bug with Admin > Message types  > Show

Add find_alert, create_alert methods to mirror find_notice, create_notice to trigger scripts.

Admin > Correspondence > Message Type - Ensure email templates have a code editor loaded

TSMS Reporting - Add support for reporting 'self funded' rather than 'unknown' for principle source of funding.

Add move_workflow function to trigger scripts; to allow patient portal assessments answers to progress workflow

Add a system user account for anonymous responses to patient portal assessments for auditing purposes

Improve trigger script share_assessment_to_patient to allow the same assessment to be shared by multiple

channels

Remove ERX Medicare expiry validation prior to sending prescription

Calendar view > Legacy layout > System displays username/email not user display name; which is a confusing UX

Ensure upload of PDF to MHR creates correspondence snapshot

Correspondence > Message Types > Template Override - numerous bug fixes to ensure current version used.

Workflow: Add a sort priority of stage name to take precedence over sort by oldest.

Fix issue with provider who isn't billing provider on billable appointment

Further improvements around removing a record from VAED submission behaviour

Assessments - 'Required' field within show_if to be validated only on condition specified

Improve migration for Hospital customers to hide FIM, SNAP by default on existing admission categories

Improve product display of radio (button group) controls on small devices in assessment system.

Healthlink - fix issue with referral letter CC to non professional contacts.

Healthlink - fix issue when sending referral letter via healthlink with an incomplete provider setup

Add versioning to Standard datasets

Assessment Elements > Item Picker > Option to hide discontinued items

Fix issue with combined payment and printing of receipt when multiple patients/invoices are in one receipt.

Visual regression: Inline form primary buttons

Admin > Message Types > Search function in Archived Tab of Message Type doesn't work

Assessments > Edit > Saved assessment being subsequently edited does not load suburb/postcode

Provider only dashboard - Fix unbatched_invoices scope issue

Datasets - add provider user email 

Fix new cases to use exceptions and better rollback handling

Improved debugging tools for ENV variables

Fix cleanup of expired telehealth links

Fix rate limit issue on merge SAML users

Datasets > Invoices > Add public attributes for bulk billing consent



Branding Settings > Show uploaded assets Datasets - add provider user email 

Invoice - Payment report showing wrong link in some circumstances.

Metrics > Level of Conciousness added as system default

Marketing Consent - Ability to disable fields where not used.

Signature controls - bulk billing - fix issues due to canvas reset on resize

Admin > Workflow > Duplicate - fails to save if certain permissions are wrong; in a very uninformative way

HL7 correspondence messages - incoming messages default to patient locations, and can be overridden on

matching correspondence.

PDF generation - Improve options to minimize file size

Provider Directory - Improve handling of bad data from Healthlink

Change to HMDS mapping behaviours when unsupported values sent

Fix minor bug in Type C admission claiming behaviour

Release Notes for CareRight 7.4.1

Defects & minor enhancements

Tasks - Filter by patient

Fix issue with merge form urls

Fix default message template labels

Fix pathology lab labels

Release Notes for CareRight 7.4.2

Defects & minor enhancements

Fix issue with document/complete tab

Release Notes for CareRight 7.4.3

Defects & minor enhancements

Fix crash in preadmissions copying

Fix bug in transaction policy for viewing own patient receipts

Fix root appointment without teams links then the rebooking one will … 

fix patient metric field label

Release Notes for CareRight 7.4.4



Fix required field behaviour/sort order customisation on patient portal (person vs patient)

Ensure provider/location is passed when creating correspondence snapshot

Fix issue with required fields in patient portal assessments when showing errors

Search IHI: IRN will be mandatory for a Medicare Card Search.

Search IHI: If the HI Service finds a unique match to the IHI record with a ‘Retired’ status, the HI Service will return

informational message (#02270), with the IHI details, depending on the configuration.

Release Notes for CareRight 7.4.5

Defects & minor enhancements

Fix Admission > Display Hidden Fields > Admission FIM Scores are now mandatory, even if 'hide FIM' is ticked.

Release Notes for CareRight 7.4.6

Defects & minor enhancements

Fix "Your reports" scope

Release Notes for CareRight 7.4.7

Defects & minor enhancements

Convert dataset adjustments to views

Release Notes for CareRight 7.4.8

Defects & minor enhancements

Datasets - fix gap with showing patient primary provider

Cases and Programs reporting improvements

Release Notes for CareRight 7.4.9

Defects & minor enhancements

Allow $0 balance account statement

Location > Can delete permissions now check if appointments are in the past before blocking archival/deletion.

Backport change to Line Allocation Log counters

Correct an issue with before edit behaviour in online enquiry based assessments

Support bulk print of invoices in the background, for performance.

Fix issue with default image not being marked as safe on initial deploy

Admin > Calendar Options > Performance improvement loading users



Fix bug with telehealth appointment editing not detecting when a normal appointment becomes telehealth

Handle malformed user input for date in online booking better

Release Notes for CareRight 7.4.10

Defects & minor enhancements

Fix AV scanning when creating letters via trigger scripts

Release Notes for CareRight 7.4.11

Defects & minor enhancements

Fix bug after stripe payment confirmation for telehealth link generation 

Release Notes for CareRight 7.4.12

Defects & minor enhancements

Fix redirect after claim generation for overnight admission thelma customers (non Express IHC)

Fix minor admin settings UI bug

Release Notes for CareRight 7.4.13

Defects & minor enhancements

Fix admin > settings > MRN defaults

Handle MIMS repeat prescription with discontinued drug

Fix bug with convert to patient failing to create health fund

Fix bug with view of results

Release Notes for CareRight 7.4.14

Defects & minor enhancements

Fix delete assessment merge forms attachment checks

Handle the attachment name is nil when encode

Fix Online Booking load more slots issue 

Fix render issue with currency formatter

Release Notes for CareRight 7.4.15

Defects & minor enhancements

Security fix for https://nvd.nist.gov/vuln/detail/CVE-2025-25291 and https://nvd.nist.gov/vuln/detail/CVE-2025-

25292

Trigger wrappers > Appointments > Handle changing status to cancelled better

https://nvd.nist.gov/vuln/detail/CVE-2025-25291
https://nvd.nist.gov/vuln/detail/CVE-2025-25292


Customer specific change to a billing wizard

Add consent for Upload My Health Record to assessments (patient fields)

Dashboard > Appointments > Optimize and skip security checking of previous/next appointments, as we are only

looking for the date

Fix escaping of database name in SQL Server specific database migration to set compatibility level

Avoid crash on unexpected medicare response status

Avoid crash on printing error

Disable Patient Account > Account statement printing on unsupported configurations

Release Notes for CareRight 7.4.16

Defects & minor enhancements

Fix minor bug with trigger script based PDF attachment rendering

Fix online booking "No appointments available" message

Release Notes for CareRight 7.4.17

Defects & minor enhancements

Fix bug with online booking 'mobile phone notes' behaviour when fields enabled

Release Notes for CareRight 7.4.18

Defects & minor enhancements

Assessment list, improve performance

Release Notes for CareRight 7.4.19

Defects & minor enhancements

Allow retrospective close of cases

Add various phone notes fields to acceptable list

Add waitlist at location level

Restrict MHR to ECDHE-RSA-AES256-GCM-SHA384 ECDHE-RSA-AES128-GCM-SHA256

If given an appointment where can_validate? is false, calendar_session_type may be nil

Fix class call issue

Customer specific billing wizard changes

Release Notes for CareRight 7.4.20



Defects & minor enhancements

Fix bug comparing admissions with a missing date field

Fix pagination for professional contacts

Patient > Admissions > Show admission category

Add tooltip to "currently admitted", showing category

Swap student SAML authentications to be inactive professional contacts

Adjust bulk billing consent UI

Fix minor bug in stripe error handling

Adopt CSV sanitisation library

Fix allocation to ignore reversed items

Add trigger script capability for attachment conversion to patient documents

Fix bulk bill override not showing on item

Release Notes for CareRight 7.4.21

Defects & minor enhancements

Change default settings to 'paranoid' mode for devise.

Increase limits for professional contact selection on appointments to 50,000 despite performance impact

Support Online Enquiry redirection configuration

Fix SQL Server compatibility migration/database name escaping

Release Notes for CareRight 7.4.22

Dashboard > Show Group Tasks



Defects & minor enhancements

Admin > System images > Show size

Assessments > Stacked Layout > Mark deprecated

Appointments > Anaesthetist > Include blank option

Appointments > Details > Render other theatre information

Dashboard > Add group tasks

Appointments > Professional Contact Pickers > Swap to an autocomplete

Correspondence Header - Avoid crash if provider not specified.

Fix missing document.gif problems

Datasets: Permit "." in names for workflow models, and fix a number of other bugs.

Bulk Billing Consent - Make name/signature fields required

Fix edge case with malformed HL7 payloads causing crash

Release Notes for CareRight 7.4.23

Defects & minor enhancements

Security > Fix inconsistency of location access checks at list view vs individual object view

Fix regression with appointment edit

Release Notes for CareRight 7.4.24

Defects & minor enhancements

Fix bug in image upload of assessments 



Fix HL7 healthlink rendering if no medicare / dva add Careright identifier

Fix ordering issue with healthlink HL7 rendering with multiple CC'd receipients

Release Notes for CareRight 7.4.25

Defects & minor enhancements

Fix display pdf Letter after virus scan

Avoid crash on upload of letter to MHR without provider

Improve performance for location occupancy

Fix Revenue Report regression from security library

Security: Fix edge case in error handling with online enquiries 

Release Notes for CareRight 7.4.26

Statutory Reporting 2025

ICD-10 13th Edition

Warning: This version still ships with ICD 10 AM 12th Edition, due to a pending licencing discussion. We expect to
resolve this prior to any production release / 1st July 2025.

CareRight now ships with an updated ICD 10 version, suitable for coding of admissions from 1st July 2025.

https://www.ihacpa.gov.au/resources/icd-10-amachiacs-thirteenth-edition

Diagnosis Cluster Identifiers (DCID)

https://www.ihacpa.gov.au/health-care/classification/icd-10-amachiacs/cluster-coding

https://meteor.aihw.gov.au/content/793121/Print?templateMode=Technical

When coding an admission, a new DCID data entry input is available.

Where there are multiple clusters, subsequent diagnoses can be added to new clusters.

https://www.ihacpa.gov.au/resources/icd-10-amachiacs-thirteenth-edition
https://www.ihacpa.gov.au/health-care/classification/icd-10-amachiacs/cluster-coding
https://meteor.aihw.gov.au/content/793121/Print?templateMode=Technical


Hospital Casemix Protocol (HCP) reporting

We've reviewed and updated CareRight's HCP reporting in the following areas:

HCP 2025: Update to AR-DRG versions, to allow v12 to be selected

HCP 2025: Mode of separation and Provider Number of Hospital to which transferred

HCP 2025: Birth weight of infant, neonate, stillborn

HCP 2025: Front end deductible (not applicable)

HCP 2025: Sex

HCP 2025: Care type

HCP 2025: Other changes

As a general reminder and following communications by AHSA, we'd like to encourage customers to ensure they review
the configured HCP Codes for guarantors against the published guides. 

https://hospitals.ahsa.com.au/hc/en-au/articles/20563171395225-AHSA-fund-codes

VAED

We've reviewed and updated CareRight's VAED reporting in the following areas:

VAED 2025: Add new Admitting/Discharging Unit/Specialty codes for Early Parenting Centres

VAED 2025: Add code 999 to Triage Score on Admission

VAED 2025: NDIS Participant Flag – reported by mental health care types

VAED 2025: Add Diagnosis Cluster Identifier (DCID) for implementation in 2025-26

Note that VAED changes to palliative care data modelling have introduced new fields; specifically:

In an Admission, where PCOC data capture is not used, Primary PCOC Phase Type is now relabelled PCOC Phase Type

at Admission; and continues to report as it did previously. A new field, PCOC Phase Type at Separation is available.

Preferred Place of Death, distinct from the existing Place of Death is required by VAED over and above the PCOC v3

standard.

Leave Days can be manually entered, where appropriate in a PCOC Phase. This is not directly linked to admission

leave.

ISAAC/APC

ISAAC/APC 2025: Add Diagnosis Cluster coding

ISAAC/APC 2025: ICD 10 13th Edition 

TSMS

https://hospitals.ahsa.com.au/hc/en-au/articles/20563171395225-AHSA-fund-codes
https://hospitals.ahsa.com.au/hc/en-au/articles/20563171395225-AHSA-fund-codes


TSMS 2025: Gender vs Sex

TSMS 2025: ICD 10 Changes, DCID

QHAPDC

QHAPDC 2025 : Report DCID

QHAPDC 2025 : ICD-10 13th Edition

HMDS

ICD 10

PHISCO

ICD-10-AM / ACHI / ACS Thirteenth Edition Implementation

PCOC v4

Not available

Defects & minor enhancements

Fix Assistant translation

Fix the assistant selection field not displaying by default

Limit Send & Print buttons for Correspondence

Correspondence > Copy letter to start new one

Fix professional contact xad rendering with no address

Fix enquiry report sql issue

Unlimited patient events

Statutory Reporting > Ability to generate a preview or subset of upcoming submission

Release Notes for CareRight 7.4.27

Release Notes for CareRight 7.4.28

ICD-10 13th Edition

Licencing resolved.

Customers are encouraged to discuss with their coding teams any relevant changes, and new Diagnosis Codes that may
apply from 1st of July.

These can be updated via Admin > Admission > Episode Diagnosis Codes.

Grouper Plus Content Services

Updated to 2025.1.3.

Admission > Diagnosis

Minor usability enhancements to reduce errors, and to make subsequent diagnosis clusters slightly easier to manage



when adding in bulk.

Defects & minor enhancements

Add "Another term" to other stat reports

Admission > Shift handover assessment > refactor to the helper, show 

Always show primary_phase_type and separation_primary_phase_type for 

Fix crash for service location not assigned to location

Fix crash on malformed frequency

Fix order and active tag issue

Fix professional contacts diabling

Fix term search

Fix to show fields if @episode.is_palliative_care?

MHR dischage_summary doesn't need contact details

NoMethodError: undefined method `invoice' for nil:NilClass

Patient Accounts > Enquiries > Print selection of invoices 

Statutory Reporting > Ability to generate a preview or subset of admissions

Release Notes for CareRight 7.4.29

Defects & minor enhancements

Statutory Reporting > Ability to preview into the future

Fix HCP values for pre 1st July 2025 admissions vs post 1st July 2025 admissions for mode of separation

Remove admission date sorting from location occupancy for older SQL Server customers

For group location assignments, default to including non open locations

Release Notes for CareRight 7.4.30



Defects & minor enhancements

Added Patient Relationship Demographics Standard Report


